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คู่มือการใช้งาน Farm1 

 เอาต์พุต Contect 5A/NO 4 ช่อง  

 อินพุตดิจทิัล 2 ช่อง  

 อินพุตแอนะล็อก 2 ช่อง  

 ต่ออุปกรณเ์สริมผ่าน RS485 และ I
2
C 

 ใช้แรงดันไฟฟ้าได้ 5V ถึง 24V 

 ใช้ ESP32 เป็นตัวประมวลผล 

 เชื่อมตอ่อินเตอร์เนต็ผ่าน WiFi 

 มีวงจรนับเวลา (RTC) ในตัว 

 ขนาด 110 x 120 x 40 มิลลิเมตร 

 

Farm1 กล่องควบคุมฟาร์มระบบ IoT ใช้ไมโครคอนโทรลเลอร์ ESP32 มาพร้อม WiFi และบลูทูธ ติดตั้ง

บนบอร์ด Farm1 รองรับการต่ออุปกรณ์ภายนอกผ่านช่องเอาต์พุต 5A/220V จ านวน 4 ช่อง ต่อ

อินพุตดิจิทัล 2 ช่อง อินพุตแอนะล็อก 2 ช่อง และ I/O จ านวน 1 ช่อง มีช่องต่อ I2C และ RS485 ใช้งาน

ได้กับเซ็นเซอร์ทุกประเภท มีวงจรนับเวลา (RTC) มาในตัว มาพร้อมกล่องติดตั้งบนรางปีกนก 

 

 

เวอรช์ั่น รายละเอียดการแก้ไข เผยแพร่ 

1.0 เพ่ิมข้อมูลทั่วไปเกี่ยวกับ Farm1 และการเขียนโปรแกรมสั่งงานเบื้องต้น 18/11/2564 

1.1 เพ่ิมวิธีการใช้งานกับ HandySense 25/11/2564 

1.2 เปลี่ยนเซ็นเซอร์หัวขอ้ HandySense จาก SHT30 เป็น SHT20 8/12/2564 
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สร้างระบบควบคุมฟาร์ม IoT อย่างรวดเร็วด้วย HandySense 

HandySense เป็นแพลตฟอร์มระบบควบคุมฟาร์มประกอบด้วยฮาร์ดแวร์และซอฟแวร์ เปิดเป็น 

Open Source เปิดให้ผู้สนใจน าไปพัฒนาต่อได้ บอร์ด Farm1 สามารถใช้งานร่วมกับระบบ Cloud ของ 

HandySense ผ่านเฟิร์มแวร์ที่ปรับแต่งมาโดยเฉพาะ โดยมีข้อก าหนดส าคัญที่ต้องใช้ฮาร์ดแวร์ เซ็นเซอร์ 

และการต่อสาย ในรูปแบบที่ผู้ผลิตก าหนดเท่านั้น 

การต่อเซ็นเซอร์เข้ากับบอร์ด Farm1 

อุปกรณ์ด้านอิเล็กทรอนิกส์ที่จ าเป็นต้องใช้ มีดังนี้  

 1. บอร์ด Farm1 2. เซ็นเซอร์วัดอุณหภูมิและความชื้น SHT20 

   

 3. เซ็นเซอร์วััดความชื้นในดิน 4. เซ็นเซอร์วัดแสง (BH1750) 

   

 5.อะแดปเตอร์ 12V 1A หัว DC Jack 
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ต่ออุปกรณ์เข้าด้วยกันดังนี้ 

 

การอัพเดทเฟิร์มแวร์ HandySense 

เปิดฝากล่อง Farm1 ออกมา แล้วใช้สาย USB-C เชื่อมต่อเข้ากับคอมพิวเตอร์ตามหัวข้อ การ

เชื่อมต่อ Farm1 เข้ากับเครื่องคอมพิวเตอร์ ติดตั้งไดร์เวอร์ตามหัวข้อ ติดตั้งไดร์เวอร์ FT231X  

อัพเดทเฟิร์มแวร์ HandySense ให้เป็นเวอร์ชั่นล่าสุด โดยใช้โปรแกรม Google Chome หรือ Microsoft 

Edge เวอร์ชั่นล่าสุด เข้าไปที่ https://www.farm1.tech/upload กดปุ่ม เชื่อมต่อและอัพโหลด  

 

https://www.farm1.tech/upload
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เลือกพอร์ตของบอร์ด แล้วกดปุ่ม เชื่อมต่อ 

 

รออัพเดทเฟิร์มแวร์ซักครู่ 
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เม่ือเสร็จแล้วจะมีข้อความแจ้ง อัพเดทเสร็จสิ้น (ดังรูป) 

 

การเพิ่มอุปกรณ์เข้าระบบ HandySense 

เข้าไปที่ dashboard.handysense.io จากนั้นสมัครสมาชิก หรือล็อกอินตามขั้นตอน 

 

  

https://dashboard.handysense.io/
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จากนั้นระบบจะพาเข้ามาหน้าแรก ซ่ึงเป็นหน้าจัดการฟาร์ม กดปุ่ม สร้างฟาร์ม 

 HandySense ออกแบบระบบให้ต้องมีฟาร์มก่อน จากนั้นจึงจะเพ่ิมอุปกรณ์ลงในฟาร์มได้ ใน 1 ฟาร์ม 

เพ่ิมได้หลายอุปกรณ์ 

 

ในหน้าต่างสร้างฟาร์ม ให้ตั้งชื่อฟาร์ม (ห้ามมีเว้นวรรค) ใส่รายละเอียด (เว้นว่างได้) จากนั้นกดปุ่ม สร้าง 
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ระบบจะพาเข้ามาหน้าฟาร์มที่สร้างอัตโนมัติ ให้กดปุ่ม เพ่ิมอุปกรณ์ เพ่ือเริ่มเพ่ิมอุปกรณ์ทันที 

 

หน้าต่างสร้างอุปกรณ์จะแสดงขึ้นมา ในขั้นตอนที่ 1 เป็นแจ้งเตือนให้เชื่อมต่ออุปกรณ์กับเครื่อง

คอมพิวเตอร์ ให้กดปุ่ม สร้างอุปกรณ์ 
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เลือกพอร์ตของอุปกรณ์ แล้วกดปุ่ม เชื่อมต่อ 

 

ขั้นตอนที่ 2 ตั้งค่าการเชื่อมต่อ WiFi ให้อุปกรณ์ แล้วกดปุ่ม ถัดไป 

 Farm1 รองรับการเชื่อมต่อ WiFi 2.4GHz เท่านั้น 

 ถ้า WiFi ไม่มีรหัสผ่าน ช่องรหัสผ่านให้เว้นวา่งไว้ 
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ขั้นตอนที่ 3 ตั้งชื่อชุดอุปกรณ์ ใส่รายละเอียด (เว้นว่างได้) แล้วกดปุ่ม ถัดไป 

 

รอประมวลผล ใช้เวลา 2 – 5 วินาที จะแสดงหน้าขั้นตอนที่ 4 สร้างอุปกรณ์เสร็จสิ้น กดปุ่ม เสร็จสิ้น 

เพ่ือปิดหน้าต่างนี้ 
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จะมีอุปกรณ์เพ่ิมเข้ามาในฟาร์มแล้ว กดที่กล่องอุปกรณ์เพ่ือดูรายละเอียด และตั้งค่าต่าง ๆ 

 

จากนั้นรอประมาณ 2 นาที (ค่าจากเซ็นเซอร์ส่งขึ้น HandySense ทุก ๆ 2 นาที) ค่าที่วัดได้จาก

เซ็นเซอร์ก็จะแสดงขึ้นมาแล้ว 

 

รายละเอียดการใช้งานระบบ ศึกษาเพ่ิมเติมได้จากเอกสาร คู่ มือการใช้งาน Web Application: 

HandySense ระบบเกษตรแม่นย า ฟาร์มอัจฉริยะ  

https://github.com/HandySense/HandySense-Manual/blob/main/HandySense%20Web%20Application%20Manual-PBRS.pdf
https://github.com/HandySense/HandySense-Manual/blob/main/HandySense%20Web%20Application%20Manual-PBRS.pdf
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ข้อมูลด้านฮาร์ดแวร์และวงจร 

คุณสมบัติทางไฟฟา้ 

คุณสมบัติ ั ต่ าสุด ปกติ สูงสุด 

แรงดันไฟฟ้า (DC/AC) 5V 12V 24V 

กระแสไฟฟ้า - - 1A 

การทนกระแสไฟฟ้าช่องเอาต์พุต - 5A/220V - 

แรงดันช่องอนิพุตดิจทิัล 3V - 12V 

กระแสช่องอินพุตดิจทิัล 0A (LOW) - 3mA (HIGH) 

แรงดันช่องอนิพุตแอนะลอ็ก 0V - 9.9V 

กระแสช่องอินพุตแอนะล็อก - - <1mA 

แรงดันช่อง I/O (D3) 0V - 3.3V 

กระแสช่อง I/O ขณะเป็นอินัพุต 0A (LOW) - 1mA (HIGH) 

กระแสช่อง I/O ขณะเป็นเอาต์พุต 0A - 10mA 

แรงดันช่อง I
2
C - 3.3V - 

แรงดันช่อง VIN แรงดันไฟเข้า – 0.6V 

แบตเตอรี่วงจรนับเวลา (RTC) 3V (CR2032) 
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ต าแหน่งขาต่อใช้งาน 

 

รูปที่ 1 ต าแหน่งขาต่อใช้งาน Farm1 

การจ่ายไฟ 

รองรับการจ่ายไฟผ่านช่อง DC / เทอมินอลปลั๊ก รองรับไฟเข้าได้ 5V และ 7V ถึง 24V (ขึ้นอยู่

กับจั้มเปอร์) ทั้งกระแสตรง (DC) และกระแสสลับ (AC) กระแสไฟฟ้าที่ต้องการต่ าสุด 1A 

จั้มเปอร VIN ใช้เลือกระดับแรงดันไฟเข้า โดยหากจั้มที่ 5V ต้องจ่ายไฟเข้า 5V เท่านั้น (DC) หาก

เลือกเป็น 7-24V เลือกจ่ายไฟด้วยหม้อแปลง แบตเตอรี่ โซล่าเซลล์ หรือแหล่งจ่ายไฟอื่นที่อยู่ในช่วง 7V 

ถึง 24V ได้ รองรับทั้งไฟฟ้ากระแสตรงและกระแสสลับ 

หลอดแอลอีดี POWER ติดสว่างเป็นสีเขียวเม่ือได้รับไฟฟ้าจากแหล่งจ่ายไฟ 
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รูปที่ 2 วงจรส่วนภาคจ่ายไฟ 

ตัวอย่างการจ่ายไฟให้บอร์ด Farm1 ด้วยสวิทชิ่งเพาเวอร์ซัพพลาย 12V แสดงดังรูปที่ 3 

 

รูปที่ 3 การจ่ายไฟให้บอร์ด Farm1 ด้วยสวิทชิง่เพาเวอร์ซัพพลาย 12V 
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ตัวอย่างการจ่ายไฟให้บอร์ด Farm1 ด้วยอะแดปเตอร์ 9V แสดงดังรูปที่ 4 

 

รูปที่ 4 การจ่ายไฟให้บอร์ด Farm1 ด้วยอะแดปเตอร์ 9V 

ช่องเอาต์พุต 

ช่องเอาต์พุตประกอบด้วย O1 ถึง O4 เป็นเอาต์พุตแบบหน้าคอนเทครีเลย์ NO ทนกระแสได้สูงสุด 

5A ที่ 220V มีหลอดแอลอีดีแสดงสถานการณ์ท างาน โดยจะติดสว่างเป็นสีส้มเม่ือหน้าคอนเทคต่อ 

(รีเลย์ท างาน) 

 

รูปที่ 5 ส่วนประกอบภาคเอาต์พุต 
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ตัวอย่างการต่อช่องเอาต์พุตเข้ากับหลอดไฟและโซลินอยด์วาล์ว แสดงดังรูปที่ 6 

 

รูปที่ 6 การต่อช่องเอาต์พุตเข้ากับหลอดไฟและโซลินอยด์วาล์ว 

 การต่อช่องเอาต์พุตเข้ากับอุปกรณ์ก าลังสูง ต้องต่อผ่านแมกเนติก (Magnetic Contactor) เท่านั้น 

รีเลย์ของช่องเอาต์พุตต่อเข้ากับ ESP32 ผ่านขา 25, 14, 12 และ 13 ตามล าดับ บล็อกไดอะแกรมส่วน

เอาต์พุตดิจิทัลแสดงดังรูปที่ 7 

 

รูปที่ 7 บล็อกไดอะแกรมส่วนเอาต์พุตดิจทิัล 
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ช่องอินพุตดิจิทัล 

ช่องอินพุตดิจิทัลประกอบด้วย D1 และ D2 รองรับไฟเข้าได้ 3V ถึง 12V คั่นระหว่างสัญญาณเข้า

กับ ESP32 ด้วยออปโต้คัปเปอร์ มีหลอดแอลอีดีสีส้ม ติดเม่ือได้รับลอจิก 1 

 

รูปที่ 8 ส่วนประกอบภาคอินพุตดิจทิัล 

ตัวอย่างการต่อสวิตช์ และลูกลอยเข้ากับช่องอินพุต แสดงดังรูปที่ 9 

 

รูปที่ 9 การต่อสวิตช์ และลูกลอยเข้ากับช่องอินพุต 
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ช่องอินพุตดิจิทัล เชื่อมต่อกับ ESP32 ผ่านออปโต้คอปเปอร์ที่ขา 34, 35 ตามล าดับ ท างานแบบ Active 

LOW เม่ือมีสัญญาณอินพุตเข้ามา สัญญาณเข้า ESP32 จะเป็น LOW และหากไม่มีสัญญาณอินพุตเข้า

มา สัญญาณเข้า ESP32 จะเป็น HIGH บล็อกไดอะแกรมส่วนอินพุตดิจิทัล แสดงดังรูปที่ 10 

 

รูปที่ 10 บล็อกไดอะแกรมส่วนอนิพุตดิจทิัล 

ช่องอินพุตแอนะล็อก 

ช่องอินพุตแอนะล็อกประกอบด้วย A1 และ A2 รองรับไฟเข้าได้ 0V ถึง 9.9V ใช้ต่อเข้ากับเซ็นเซอร์

ที่ให้เอาต์พุตเป็นแรงดันไฟฟ้า เช่น เซ็นเซอร์วัดความชื้นในดิน, เซ็นเซอร์วัดระดับน้ า, เซ็นเซอร์วัดความขุ่น

ของน้ า, เซ็นเซอร์วัดความเป็นกรด-ด่าง (PH) เป็นต้น 

 

รูปที่ 11 ส่วนประกอบภาคอินพุตแอนะล็อก 
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ตัวอย่างการต่อเซ็นเซอร์วัดความชื้นในดินเข้ากับช่องอินพุตแอนะล็อก แสดงดังรูปที่ 12 

 

รูปที่ 12 การต่อเซ็นเซอร์วัดความชื้นในดินเข้ากบัช่องอินพุตแอนะล็อก 

อินพุตแอนะล็อกผ่านวงจรบัพเฟอร์จากนั้นเข้าวงจรแบ่งแรงดันเพ่ือให้แรงดันไม่เกิน 3.3V ท าให้ ESP32 

สามารถรับแรงดันสูงได้ ช่องแอนะล็อกต่อกับ ESP32 ขา 36, 39 ตามล าดับ บล็อกไดอะแกรมส่วน

อินพุตแอนะล็อก แสดงดังรูปที่ 12 

 

รูปที่ 13 บล็อกไดอะแกรมส่วนอนิพุตแอนะลอ็ก 

ช่อง I/O 

ช่อง I/O คือ D3 รองรับแรงดันไฟเข้าสูงสุด 3.3V ใช้ต่อกับกับเซ็นเซอร์/อุปกรณ์ภายนอกสื่อสาร

ด้วยสายเส้นเดียว เช่น เซ็นเซอร์วัดอุณหภูมิและความชื้น DHT11/DHT22, เซ็นเซอร์วัดอุณหภูมิแบบกัน

น้ า DS18B20, หลอดแอลอีดี RGB เบอร์ WS2812, เซอร์โวมอเตอร์ เป็นต้น 
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รูปที่ 14 ส่วนประกอบภาค I/O 

ตัวอย่างการต่อเซ็นเซอร์วัดอุณหภูมิหัวกันน้ า DS18B20 เข้ากับช่อง I/O แสดงดังรูปที่ 15 

 DS18B20 ท างานแบบ 1-wire ตามข้อก าหนด ต้องตอ่ตัวต้านทาน Pull-up ดว้ย 

 

รูปที่ 15 การต่อเซ็นเซอรว์ัดอุณหภูมิหัวกันน้ า DS18B20 เข้ากับช่อง I/O 

ช่อง I/O ต่อตรงกับ ESP32 ขา 26 คั่นด้วยตัวต้านทาน 100Ω เพ่ือป้องกันกระแสไหลเกิน พร้อมตัว

ต้านทาน 4.7 kΩ เป็น Pull-up บล็อกไดอะแกรมส่วน I/O แสดงดังรูปที่ 16 

 

รูปที่ 16 บล็อกไดอะแกรมส่วน I/O 
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ช่อง I
2
C 

ช่อง I
2
C ประกอบด้วย SCL และ SDA ใช้ต่อกับอุปกรณ์ I

2
C เช่น เซ็นเซอร์วัดอุณหภูมิและ

ความชื้น SHT30, เซ็นเซอร์วัดความกดอากาศ BMP280, เซ็นเซอร์แสง BH1750 เป็นต้น ใช้งานได้กับ

อุปกรณ์ที่ใช้แรงดันไฟฟ้า 3.3V มีหลอดแอลอีดีกระพริบบอกสถานะรับ-ส่งข้อมูล 

 

รูปที่ 17 ส่วนประกอบภาค I
2
C 

การต่อกับเซ็นเซอร์ จ าเป็นจะต้องต่อขา SCL และ SDA ให้ถูกต้อง ตัวอย่างการต่อเซ็นเซอร์วัดอุณหภูมิ

และความชื้น SHT20 แสดงดังรูปที่ 18 

 

รูปที่ 18 การต่อเซ็นเซอร์วัดอุณหภูมิและความชื้น SHT30 เข้ากับช่อง I
2
C 
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ช่อง I2C ต่อตรงกับ ESP32 ขา 22 (SCL), 21 (SDA) โดยมีตัวต้านทาน Pull-up 10kΩ ต่อไว้ให้แล้ว 

บล็อกไดอะแกรมส่วน I
2
C แสดงดังรูปที่ 19 

 

รูปที่ 19 บล็อกไดอะแกรมส่วน I2C 

ช่อง RS485 

ช่อง RS485 ประกอบด้วย A+ และ B- ใช้ต่อกับเซ็นเซอร์ RS485 หรือ Modbus RTU เช่น 

เซ็นเซอร์วัดความชื้นในดิน เซ็นเซอร์อุณหภูมิ เซ็นเซอร์วัดระดับน้ าฝน เซ็นเซอร์วัดความเร็วลม เป็นต้น 

ช่อง RS485 บนบอร์ดมี Resistor Termination ค่าความต้านทาน 120Ω มาให้แล้ว พร้อม TVS 

ป้องกันแรงดันไฟฟ้าในบัสสูงเกินก าหนด 

 

รูปที่ 20 ส่วนประกอบภาค RS485 
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ตัวอย่างการต่อเซ็นเซอร์วัดอุณหภูมิและความชื้น XY-MD02 เข้ากับช่อง RS485 แสดงดังรูปที่ 21 

 

รูปที่ 21 การต่อเซ็นเซอร์วัดอุณหภูมิและความชื้น XY-MD02 เข้ากับ Fame1 

ช่อง RS485 ต่อกับ ESP32 ผ่านวงจรแปลง RS485 เป็น UART เข้าที่ขา 4 (RX), 15 (TX) และ 2 

(DIR) บล็อกไดอะแกรมส่วน RS485 แสดงดังรูปที่ 22 

 

รูปที่ 22 บล็อกไดอะแกรมส่วน RS485 

วงจรนับเวลา (RTC) 

วงจรนับเวลาต่อตรงกับ ESP32 ผ่านช่อง I
2
C ใช้นับเวลาเม่ือไม่มีอินเตอร์เน็ต หรือเม่ือไม่มีไฟเลี้ยง 

ใช้ประกอบการเขียนโปรแกรมที่ต้องการให้ท างานตามเวลา เช่น ส่งค่าที่วัดได้ในฟาร์มขึ้นระบบคลาวด์ตาม

เวลา เปิด-ปิดไฟตามเวลา เปิด-ปิดป้ัมน้ าตามเวลา เป็นต้น 

วงจรนับเวลา (RTC) จ าเป็นต้องใช้ถ่าน CR2032 จ่ายไฟเลี้ยงให้วงจร โดยไฟจากถ่านจะถูกใช้เม่ือ

ไม่มีแรงดันจากแหล่งจ่ายไฟจ่ายเข้ามา ท าให้วงจรส่วนนับเวลา (RTC) ยังมีไฟเลี้ยงอยู่ตลอด ท าให้วงจรยัง
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ท างาน นับเวลาอยู่เรื่อย ๆ จดจ าค่าเวลาได้ และพร้อมให้เรียกใช้ค่าเวลาเม่ือวงจรส่วนประมวลผลกลับมา

ท างานอีกครั้ง 

 

รูปที่ 23 ส่วนประกอบวงจรนับเวลา (RTC) 

บล็อกไดอะแกรมส่วนวงจรนับเวลา (RTC) แสดงดังรูปที่ 24 

 

รูปที่ 24 บล็อกไดอะแกรมส่วนวงจรนับเวลา (RTC) 
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การเขียนโปรแกรมสั่งงานด้วย Arduino IDE 

Farm1 ใช้ไมโครคอนโทรลเลอร์ ESP32 ในการประมวลผล รองรับเครื่องมือพัฒนาทั้ง ESP-IDF 

และ Arduino IDE ในเอกสารนี้จะแนะน าตัวอย่างการเขียนโปรแกรมแต่ละส่วนด้วย Arduino IDE 

ติดตั้งโปรแกรม Arduino IDE 

โปรแกรม Arduino IDE เป็นหนึ่งในเครื่องมือที่ใช้พัฒนาโปรแกรมให้ Farm1 ซ่ึงประกอบไปด้วย 

Text Editor ใช้แก้ไขโค้ดโปรแกรม, Compiler และ Uploader 

ขั้นตอนการติดตั้งโปรแกรม Arduino IDE มีดังนี้ 

เข้าไปที่ http://www.arduino.cc/en/Main/Software เลือก OS ให้ตรงกับเครื่องคอมพิวเตอร์  

 

กดปุ่ม JUST DOWNLOAD เพ่ือเริ่มดาว์โหลดโปรแกรม 

 

รอจนกว่าการดาว์โหลดจะเสรจ็สิ้น แล้วจึงท าขัน้ตอนถัดไป 

 

http://www.arduino.cc/en/Main/Software
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เม่ือดาว์โหลดเสร็จแลว้ให้เปิดไฟล์ติดตั้งขึ้นมา แล้วกดปุ่ม I Agree เพ่ือยืนยันยอมรับเงือ่นไขการใช้งาน

โปรแกรม 

 

คลิกปุ่ม Next > เพ่ือติดตั้งทั้งหมด 

 

เลือกโฟลเดอร์ตดิตั้งโปรแกรม หากไม่ต้องการแก้ไขคลิกปุ่ม Install 
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รอจนกว่าโปรแกรมจะติดตั้งเสร็จสิ้น 

 

เม่ือขึ้นค าว่า Completed ให้กดปุ่ม Close เพ่ือปิดหน้าต่างติดตั้งโปรแกรมได้เลย 

 

หน้าเดสท็อปก็จะมีไอค่อนโปรแกรม Arduino ขึ้นมาแล้ว 

 

ติดตั้งไดร์เวอร์ FT231X 

บอร์ด IOXESP32+ เป็นบอร์ดที่ใช้พัฒนา ESP32 เสียบอยู่บน Farm1 มีวงจรอัพโหลดโปรแกรมบน

บอร์ดผ่านชิปแปลง USB เป็น UART เบอร์ FT231X ซ่ึงจ าเป็นต้องติดตั้งไดร์เวอร์ก่อนจึงจะอัพโหลด

โปรแกรมเข้าได้ 
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เข้าไปที่ https://ftdichip.com/drivers/vcp-drivers/ กดดาวน์โหลดไฟล์ตาม OS ของเครื่อง

คอมพิวเตอร์ 

 

จะได้ ไฟล์มา CDM vxxxxx WHQL Certified.zip  ให้แตกไฟล์ด้วยโปรแกรม  WinRAR, 7-Zip

 

เข้าไปในโฟลเดอร์ที่แตกไฟล์มา แล้วคลิกขวาที่ไฟล์ ftdiport.inf กด Install 

  

https://ftdichip.com/drivers/vcp-drivers/
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จากนั้นหน้าต่างให้ยืนยันจะแสดงขึ้นมา ให้กดปุ่ม Yes หากติดตั้งส าเร็จ จะมีข้อความแจ้ง (ดังรูป) 

 

เปิด Device Manager ขึ้นมา โดยพิมพ์ในช่องค้นหา 

 

เสียบสาย USB ตามหัวข้อ การเชื่อมต่อ Farm1 เข้ากับเครื่องคอมพิวเตอร์ จากนั้นสังเกตในหน้าต่าง 

Device Manager จะต้องมีหัวข้อ Ports และมี USB Serial Port ขึ้น เป็นอันเสร็จสิ้นการติดตั้งไดร์เวอร ์
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การเพิ่มบอร์ด ESP32 ลงโปรแกรม Arduino IDE 

โปรแกรม Arduino IDE เดิมรองรับการเขียนโปรแกรมสั่งงานเฉพาะบอร์ดที่ผลิตโดย Arduino 

เท่านั้น หากต้องการใช้เขียนโปรแกรมให้ ESP32 จ าเป็นต้องติดตั้งบอร์ด ESP32 เพ่ิม โดยติดตั้ง 

Arduino core for the ESP32 

เปิดโปรแกรม ArduinoIDE ขึ้นมา โดยดับเบิลคลิกที่ไอค่อน Arduino บนหน้าเดสท็อป กด File เลือก 

Preferences 

 

ในช่อง Additional Boards Manager URLs ใส่  

https: / / raw. githubusercontent. com/ espressif/ arduino- esp32/ gh-

pages/package_esp32_index.json 

แล้วกดปุ่ม OK (ในรูปเป็นลิ้งเก่า ให้ใส่ลิ้งใหม่ด้านบน) 
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จากนั้นกด Tools > Board เลือก Boards Manager... 

 

จากนั้นกด Type เลือก Contributed 

 

เลื่อนหา esp32 แล้วกดปุ่ม Install 

 

เม่ือติดตั้งเสร็จแล้ว จะแสดงค าว่า INSTALLED กดปุ่ม Close เพ่ือปิดหน้าต่าง เป็นอันเสร็จสิ้นการเพ่ิม

บอร์ด ESP32 ลงโปรแกรม Arduino IDE 
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การเช่ือมต่อ Farm1 เข้ากับเครื่องคอมพิวเตอร์ 

ใช้สาย USB-C เสียบช่อง USB-C บนบอร์ด IOXESP32+ ปลายอีกด้านของสายเสียบเข้ากับ

เครื่องคอมพิวเตอร์ 

 สาย USB-C หาซ้ือได้ทั่วไปตามร้านขายอุปกรณ์ IT, ร้านโทรศัพท์, ร้านสะดวกซ้ือ, ห้างสรรพสินค้า 

 

รูปที่ 24 การเชื่อมต่อ Farm1 เข้ากับเครือ่งคอมพิวเตอร์ดว้ยสาย USB-C 

ทดสอบอัพโหลดโปรแกรมไฟกระพริบ 

ที่โปรแกรม Arduino IDE กดไปที่ File > Examples > 01.Basics เลือก Blink 
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แก้ไข LED_BUILIN ให้เป็น 25 (ขา O1) 

 

เลือกบอร์ดให้ถูกต้อง โดยกด Tool > Board > ESP32 Arduino เลือกบอร์ด ESP32 Dev Module 
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เลือกพอร์ตให้ถูกต้อง โดยกดไปที่ Tool > Port เลือก COM... ที่มีให้เลือก  

 หากไม่ขึ้นพอร์ตให้เลือก ให้ตรวจสอบสาย USB-C ว่าเสียบแน่นแล้วหรือยัง โดยสังเกตบอร์ด 

IOXESP32+ ไฟ PWR สีเขียวต้องติดสว่าง หากคาดว่าบอร์ดท างานปกติ ให้ตรวจสอบการติดตั้งไดร์

เวอร์ FT231Xอีกครั้ง 

 

กดปุ่ม  เพ่ือคอมไพล์และอัพโหลดโปรแกรมลงบอร์ด (เวลาที่ใช้ในการคอมไพล์และอัพโหลดอาจถึง 2 

นาที หากไม่มีข้อความแจ้ง Error หรือ Done uploading ให้รอก่อน) 

 

หากคอมไพล์และอัพโหลดโปรแกรมส าเร็จ จะมีข้อความ Done uploading แสดงขึ้นมา (ดังรูป) 

 

ผลลัพธ์ที่ได้ ไฟที่ช่อง O1 จะกระพริบทุก ๆ 1 วินาที พร้อมมีเสียงรีเลย์ตัด-ต่อ 
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เขียนโปรแกรมสั่งงานช่องเอาต์พุต 

ใช้ค าสั่ง pinMode() และ digitalWrite() ในการเขียนโปรแกรมสั่งงานช่องเอาต์พุต 

ก าหนดแทนที่ O1_PIN, ..., O4_PIN ด้วยหมายเลขขาที่ต่อกับ ESP32 ดังนี้ 

1. #define O1_PIN 25 
2. #define O2_PIN 14 
3. #define O3_PIN 12 
4. #define O4_PIN 13 

 ใน void setup() ใช้สั่ง pinMode() ก าหนดขา O1 ถึง O4 เป็นเอาต์พุต 

1. void setup() { 
2.   pinMode(O1_PIN, OUTPUT); 
3.   pinMode(O2_PIN, OUTPUT); 
4.   pinMode(O3_PIN, OUTPUT); 
5.   pinMode(O4_PIN, OUTPUT); 
6. } 

ใน void loop() ใช้ค าสั่ง digitalWrite() สั่งให้รีเลย์ช่อง O1 ตัด-ต่อทุก ๆ 1 นาที  

1. void loop() { 
2.   digitalWrite(O1_PIN, HIGH); 
3.   delay(1000); 
4.   digitalWrite(O1_PIN, LOW); 
5.   delay(1000); 
6. } 

ได้โค้ดโปรแกรมที่สมบูรณ์ดังนี้ 

1. #define O1_PIN 25 
2. #define O2_PIN 14 
3. #define O3_PIN 12 
4. #define O4_PIN 13 
5.   
6. void setup() { 
7.   pinMode(O1_PIN, OUTPUT); 
8.   pinMode(O2_PIN, OUTPUT); 
9.   pinMode(O3_PIN, OUTPUT); 
10.   pinMode(O4_PIN, OUTPUT); 
11. } 
12.   
13. void loop() { 
14.   digitalWrite(O1_PIN, HIGH); 
15.   delay(1000); 
16.   digitalWrite(O1_PIN, LOW); 
17.   delay(1000); 
18. } 
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อัพโหลดโปรแกรมลงบอร์ด จะได้ยินเสียงรีเลย์ตัด-ต่อ และไฟช่องเอาต์พุตติด-ดับ ทุก ๆ 2 วินาที 

เขียนโปรแกรมอ่านช่องอินพุตดิจิทัล 

ใช้ค าสั่ง pinMode() และ digitalRead() ในการอ่านค่าช่องอินพุตดิจิทัล 

ก าหนดแทนที่ O1_PIN, ..., O4_PIN และ D1_PIN, D2_PIN ด้วยหมายเลขขาที่ต่อกับ ESP32 ดังนี้ 

1. #define O1_PIN 25 
2. #define O2_PIN 14 
3. #define O3_PIN 12 
4. #define O4_PIN 13 
5.   
6. #define D1_PIN 34 
7. #define D2_PIN 34 

ใน void setup() ใช้สั่ง pinMode() ก าหนดขา O1 ถึง O4 เป็นเอาต์พุต และก าหนดขา D1 และ D4 เป็น

อินพุตดิจิทัล 

1. void setup() { 
2.   pinMode(O1_PIN, OUTPUT); 
3.   pinMode(O2_PIN, OUTPUT); 
4.   pinMode(O3_PIN, OUTPUT); 
5.   pinMode(O4_PIN, OUTPUT); 
6.    
7.   pinMode(D1_PIN, INPUT); 
8.   pinMode(D2_PIN, INPUT); 
9. } 

 ใน void loop() ใช้ค าสั่ง digitalRead() อ่านค่าเก็บลงตัวแปร value ชนิด int  

1.    int value = digitalRead(D1_PIN); 

ใช้ค าสั่ง if ตรวจสอบค่าในตัวแปร value หากได้ 0 ให้สั่งรีเลย์ช่อง O1 ท างาน ใช้ค าสั่ง else หากเงื่อนไข

ใน if ไม่เป็นจริง ให้รีเลย์ช่อง O1 หยุดท างาน 

2.    if (value == 0) { 
3.     digitalWrite(O1_PIN, HIGH); 
4.   } else { 
5.     digitalWrite(O1_PIN, LOW); 
6.   } 
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ได้โค้ดโปรแกรมที่สมบูรณ์ดังนี้ (ดาวน์โหลดโค้ดโปรแกรมได้ที่ ) 

1. #define O1_PIN 25 
2. #define O2_PIN 14 
3. #define O3_PIN 12 
4. #define O4_PIN 13 
5.   
6. #define D1_PIN 34 
7. #define D2_PIN 34 
8.   
9. void setup() { 
10.   pinMode(O1_PIN, OUTPUT); 
11.   pinMode(O2_PIN, OUTPUT); 
12.   pinMode(O3_PIN, OUTPUT); 
13.   pinMode(O4_PIN, OUTPUT); 
14.    
15.   pinMode(D1_PIN, INPUT); 
16.   pinMode(D2_PIN, INPUT); 
17. } 
18.   
19. void loop() { 
20.   int value = digitalRead(D1_PIN); 
21.   if (value == 0) { 
22.     digitalWrite(O1_PIN, HIGH); 
23.   } else { 
24.     digitalWrite(O1_PIN, LOW); 
25.   } 
26.   delay(10); 
27. } 

อัพโหลดโปรแกรมลงบอร์ด ที่ช่อง D1 ด้านนึงต่อเข้ากับ GND อีกด้านใช้สายลอย (ดังรูปที่ ...) แตะกับ 

5V หรือ VIN สังเกตไฟสีส้มของช่อง D1 จะติดเม่ือแตะโดน และจะดับเม่ือน าออก ส่วนรีเลย์ช่อง O1 จะ

ท างานเม่ือแตะสายไฟ และหยุดท างานเม่ือน าสายไฟออก 

เขียนโปรแกรมอ่านช่องอินพุตแอนะล็อก 

ใช้ค าสั่ง analogRead() อ่านค่าช่องอินพุตแอนะล็อก ได้ค่า 0 ถึง 4095 เม่ือ 4095 เทียบได้กับแรงดัน 

9.9V (ตามวงจรในหัวข้อ ช่องอินพุตแอนะล็อก) 

ก าหนดแทนที่ A1 และ A2 ด้วย 36 และ 39 ตามล าดับ 

1. #define A1_PIN 36 
2. #define A2_PIN 39 
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ใน void loop() ใช้ค าสั่ง analogRead() อ่านค่าแอนะล็อกจาก A0 แล้วน าค่าที่ได้เทียบัญญัติไตรยางค์

เพ่ือแปลงเป็นแรงดัน เก็บลงตัวแปร volt ชนิด float 

1.   float volt = analogRead(A1_PIN) / 4095.0 * 9.9; 

 ใช้ค าสั่ง Serial.println() ให้แสดงค่าในตัวแปร volt ออกมาทาง Serial Monitor 

2.   Serial.println(volt); 

 ได้โค้ดโปรแกรมที่สมบูรณ์ดังนี้ 

3. #define A1_PIN 36 
4. #define A2_PIN 39 
5.   
6. void setup() { 
7.   Serial.begin(115200); 
8. } 
9.   
10. void loop() { 
11.   float volt = analogRead(A1_PIN) / 4095.0 * 9.9; 
12.   Serial.println(volt); 
13.   delay(10); 
14. } 

อัพโหลดโค้ดโปรแกรมลงบอร์ด เปิด Serial Monitor โดยกด  ตั้ง band เป็น 115200 แล้วทดลอง

จั้มระหว่าง A1 กับ 5V จากนั้นทดสอบจั้มระหว่าง A1 กับ 3.3V สังเกตผลที่ได้ใน Serial Monitor จะ

ต่างกัน 

 วงจรส่วนแอนะล็อกใช้ไฟจาก VIN จึงจ าเป็นต้องต่อไฟเข้า VIN เพ่ือให้วงจรแอนะล็อกท างานได้ถูกต้อง 
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เขียนโปรแกรมช่อง I/O อ่านค่าอุณหภูมิจาก DS18B20 

ต่อวงจรตามหัวข้อ ช่อง I/O ติดตัง้ไลบารี่ OneWire ตามขั้นตอนดังนี ้

เข้าไปที่ https://github.com/PaulStoffregen/OneWire กด Code แล้วกด Download ZIP  

 

จะได้ไฟล์ OneWire-master.zip มา 

 

ที่โปรแกรม Arduino IDE กด Sketch > Include Library เลือก Add .ZIP Library 

 

เลือกไฟล์ OneWire-master.zip ที่ดาวน์โหลดมา กดปุ่ม Open 

 

https://github.com/PaulStoffregen/OneWire
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หากติดตั้งส าเร็จ จะมีข้อความ Library added ขึ้น (ดังรูป) 

 

ติดตั้งไลบารี่ DallasTemperature ด้วย Library Manager ตามขั้นตอนดังนี้ 

กด Sketch > Include Library เลือก Manage Libraries 

  

หน้าต่าง Library Manager จะแสดงขึ้นมา ให้ค้นหา DallasTemperature แล้วเลือกกดปุ่ม Install 

ไลบารี่ by Miles Burton 
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เม่ือติดตัง้เสร็จแล้ว จะมีข้อความ INSTALLED แสดง (ดังรูป) กดปุ่ม Close เพ่ือปิดได้เลย 

 

ดาวน์โหลดโปรแกรมตัวอย่างจาก https://bit.ly/3HkpJx5 อัพโหลดโปรแกรมลงบอร์ด แล้วเปิด 

Serial Monitor ขึ้นมา โดยกด  

 

เลือก 115200 band หากต่อวงจรถูกต้อง เซ็นเซอร์ท างานได้ จะมีอุณหภูมิในหน่วยองศาเซลเซียส และ

องศาฟาเรนไฮต์แสดงขึ้นมา 

 

https://bit.ly/3HkpJx5
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เขียนโปรแกรมช่อง I
2
C อ่านค่าอุณหภูมิและความช้ืนจาก SHT30 

ต่อวงจรตามหัวข้อ ช่อง I2C ติดตั้งไลบารี่ ClosedCube SHT31D ด้วย Library Manager จากนั้นเปิด

โค้ดโปรแกรมตัวอย่าง periodicmode ขึ้นมา 

 

อัพโหลดโปรแกรมลงบอร์ด เปิด Serial Monitor ขึ้นมา ปรับ band เป็น 9600 ค่าอุณหภูมิและ

ความชื้นที่ SHT30 วัดได้จะแสดงขึ้นมา 

 หากมีข้อความ Periodic Mode: [ERROR] ให้แก้ไขหมายเลขของอุปกรณ์บรรทัดที่ 32 จาก 0x44 

เป็น 0x45 อัพโหลดโปรแกรมแล้วดูผลอีกครั้ง 
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เขียนโปรแกรมช่อง RS485 อ่านค่าอุณหภูมิและความช้ืนจาก XY-MD02 

ต่อวงจรตามหัวข้อ ช่อง RS485 ติดตั้งไลบารี่ ModbusMaster ด้วย Library Manager จากนั้นดาวน์

โหลดโค้ดตัวอย่างจาก https://bit.ly/3ccUxRV แก้ไขหมายเลขอุปกรณ์ (Device ID) ของ XY-

MD02 ให้ถูกต้อง (ค่าจากโรงงาน เป็น ID: 1) อัพโหลดโปรแกรมลงบอร์ด 

 

เปิด Serial Monitor ขึ้นมา ปรับ Band เป็น 115200 หากต่อวงจรถกูตอ้ง เซ็นเซอรท์ างานได้ ค่า

อุณหภูมิและความชื้นที่วัดได้จะแสดงขึ้นมา 

 

  

https://bit.ly/3ccUxRV
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เขียนโปรแกรมตั้งเวลาและอ่านค่าเวลาจากวงจรนับเวลา (RTC) 

ติดตั้งไลบารี่ Artron DS1338 ด้วย Library Manager เปิดตวัอย่างโค้ดจากเมนู File > Examples > 

Artron DS1338 > DS1338_set_get_datetime 

 

อัพโหลดโปรแกรมตัวอย่างลงบอร์ด เปิด Serial Monitor ปรับ 115200 band  ผลที่ได้คือ เวลาใน RTC 

จะถกูตั้ง และแสดงเวลาทีน่ับขึ้นเรื่อย ๆ บน Serial Monitor 

 

ค าแนะน าการติดตั้ง 

อุปกรณ์รองรับการติดตั้งบนรางปีกนก ไม่กันน้ า การใช้งานจริงจึงควรติดตั้งบนรางปีกนกในกล่อง

กันน้ า รูร้อยสายใฟที่เข้ากล่องควรใช้คอนดนคเตอร์แบบกันน้ า หรือใช้ เคเบิ้ลแกลนด์ เพ่ือป้องกันน้ าเข้า

ภายในกล่อง ควรรักษาอุณหภูมิให้ไม่เกิน 80 องศาเซลเซียส ซ่ึงอาจท าให้อุปกรณ์อิเล็กทรอนิกส์

เสียหาย การเก็บรักษาควรเก็บในที่แห้ง ไม่โดนแดดโดยตรง 



  กล่องควบคุมฟาร์มระบบ IoT 

  หน้าท่ี 46 

พาวเวอร์ซัพพลายควรเลือกใช้รุ่นที่สามารถทนไฟกระชากได้ มีระบบตัดไฟเม่ือกระแสเกิน มี

อุปกรณ์ป้องกันฟ้าผ่า โดยอาจสังเกตและเลือกใช้พาวเวอร์ซัพพลายที่มีสัญลักษณ์ CE หรือ มอก. 

พร้อมติดตั้งเบรกเกอร์เพ่ือใช้ปิดอุปกรณ์เม่ือต้องบ ารุงรักษา 

แนวทางการแก้ไขปัญหา 

ปัญหา แนวทางแก้ไข 

ปัญหาเอาต์พุต 

ใช้ค าสั่ง digitalWrite() แต่รีเลย์ไมท่ างาน ไฟ

เอาต์พุตไม่ติด 

เป็นได้ทั้งปัญหาซอฟแวร์และปัญหาด้านฮาร์ดแวร์ 

 อาจลืมใช้ค าสั่ง pinMode() หรือใช้ไม่

ถูกตอ้ง ก่อนเรียกใช้ digitalWrite() 

 ใช้ค าสั่ง digitalWrite() ผิดขา 

 ESP32 รีเซ็ตก่อนท างานถึงค าสั่ง 

digitalWrite() (ให้เปิด Serial Monitor 

ขึ้นมาดู) 

 บอร์ด IOXESP32+ หลวม ท าให้ไฟฟ้า

ไม่สามารถไหลได้ 

 กระแสไฟฟ้าจากแหล่งจ่ายไม่เพียงพอให้

อุปกรณ์ท างานได้ปกต ิ

ไฟติด-ดับ แต่ไม่มีเสียงรีเลย์ตัด-ต่อ  รีเลย์เสีย 

ปัญหาอินพุตดิจิทัล 

ใช้ค าสั่ง digitalRead() ได้ค่าเป็น 1 หรือเป็น 0 

ตลอดเวลา 

 ให้สังเกตไฟตรงจดุเอาต์พุต หากต่อวงจร

ให้ต้องเป็น 1/0 แต่ไฟไม่ติด-ไม่ดับ เป็น

ปัญหาด้านฮาร์ดแวร์หรือระบบไฟฟ้า ให้

ใช้มัลติมิเตอร์ตรวจสอบแรงดันแต่ละจดุ  

 หากไฟติด-ดับปกติ ให้ตรวจสอบโค้ด

โปรแกรมว่าอ่านออกมาถูกขา 

 ตรวจสอบว่าใช้ค าสั่ง pinMode() กอ่น

ใช้ค าสั่ง digitalRead() แล้ว 
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ปัญหาอินพุตแอนะล็อก 

วัดแรงดันได้สูงสุด 2V กว่า ๆ แม้จะป้อนแรงดัน

มากกว่านี้ 

เกิดจากไม่ไดจ้่ายไฟเข้า VIN 7V ถึง 12V วงจร

อินพุตแอนะล็อกใช้ไฟจาก VIN ในการท างาน หาก

ไม่จ่ายไฟ ค่าที่วัดได้จะไม่ถูกต้อง 

วัดแรงดันได้ไม่ตรง เป็นปัญหาในระดับชิป ให้ใช้ไลบารี่ 

ESP32AnalogRead อ่านแรงดันแทน จะให้ค่าที่

ตรงความเป็นจริงมากขึ้น 

ช่อง I
2
C 

ติดต่อกับอุปกรณ์ I
2
C ไม่ได้ สังเกตไฟช่อง I

2
C ว่ากระพริบหรอืไม่ หาก

กระพริบแสดงว่ามีการส่งข้อมูลออกจากบอร์ด

แล้ว แต่อุปกรณ์ปลายทางอาจไม่ได้รับ หรือไม่

ท างาน หากไฟไม่กระพริบ แสดงว่าไม่มีข้อมูล

ส่งออกจากบอร์ด ให้ตรวจสอบโค้ดโปรแกรม 

ช่อง RS485 

ติดต่อกับอุปกรณ์ RS485 ไม่ได้ สังเกตไฟช่อง RS485 ตรง TX ว่ากระพริบ

หรือไม่ หากกระพริบแสดงว่ามีการส่งข้อมูลออก

จากบอร์ดแล้ว จากนัน้ให้สังเกตไฟ RX ว่าท างาน

อย่างไร 

 ไฟ RX กระพริบ แสดงว่าอุปกรณ์

ปลายทางส่งข้อมูลเข้ามาแล้ว แต่ฝั่ง 

Farm1 รับข้อมูลไม่ได้ ให้ตรวจสอบโค้ด

โปรแกรม 

 ไฟ RX ไม่กระพริบ แสดงว่าอุปกรณ์

ปลายทางไม่ตอบสนอง อาจเป็นไปไดว้่า

หมายเลข ID ของอุปกรณ์ที่ร้องขอขอ้มูล

ไม่มีอยู่ หรือ ID ของอุปกรณ์ผิด ให้ใช้

โปรแกรม CAS Modbus Scanner ลอง

สแกนหา ID ดูก่อน รวมทั้งอาจ

ตรวจสอบการตั้งค่า Band Rate และ 
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Prarity ด้วย ว่าตั้งค่าไว้ตรงกับที่

อุปกรณ์ต้องการหรือไม ่

หากไฟ TX ไม่กระพริบ 

 ยังส่งข้อมูลออกไม่ได้ ให้ตรวจสอบโค้ด

โปรแกรม 

ปัญหาวงจรนับเวลา 

เวลาไม่ถูกต้องหลังตัดไฟ ไม่ได้ใส่แบตเตอรี่ หรือแบตเตอรี่หมด 
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บริษัท อาร์ทรอน ชอป จ ากัด รับพัฒนาสินค้าอิเล็กทรอนิกส์ บอร์ดอิเล็กทรอนิกส์ ด้านระบบ IoT 

พัฒนาเว็บไซต์ระบบ IoT ด้วย ReactJS / Next.js รับท าระบบหลังบ้านให้อุปกรณ์ IoT รับเขียนเฟิร์ม

แ ว ร์ อุ ป ก รณ์  IoT ด้ ว ย  Arduino IDE /  PlatformIO /  Atmel Studio /  MPLAB IDE / 

STM32CubeIDE / IAR / ESP-IDF / Arm Keil รับจัดหาชิ้นส่วนอิเล็กทรอนิกส์ ออกใบเสนอราคา 

และใบก ากับภาษีได้ 

ติดต่อสอบถามข้อมูลเพิ่มเติม 

 เว็บไซต์ www.artronshop.co.th 

 โทร: 02 003 3688 (ส านักงาน) 

 อีเมล: contact@atronshop.co.th 

 LINE: @artronshop 

 Facebook: ArtronShop 

 Youtube: ArtronShop 

 

 

https://www.artronshop.co.th/
https://www.facebook.com/artronshop
https://www.youtube.com/channel/UCPZZ_UUolU4dss5KJaoQPgQ
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